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O0yssée Version 1.6
Manuel de ’'utilisateur

Résumé : OQyssée est un logiciel de différentiation automatique de programmes FOR-
TRAN 77 qui implémente & la fois les modes direct et inverse de différentiation automatique.
La version courante d’Odyssée est la version 1.6. Elle est composée d’une boite & outils,
d’un interpréte du langage de commande qui permet d’accéder & ces outils et d’une interface
graphique & ce langage.

Ce rapport présente les principales fonctionnalités d’Odyssée ainsi que les concepts et les
objets de base. De plus, il documente complétement le langage de commande d’Odyssée et
son interface graphique.

Mots-clés : Odyssee, différentation automatique, fortran, transformation de programme
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Chapter 1

Introduction

What is O0dyssée?

OOQyssée is an automatic differentiation software performing transformations of FORTRAN 77
codes:

Given a set of FORTRAN 77 units which compute a numerical function f, and a
list of input variables, it produces FORTRAN 77 subroutines which compute the
derivatives of f whith respect to those variables.

Compared to other automatic differentiation tools', the key features of O9yssée are:
e to implement both the forward and reverse mode of automatic differentiation,

e to be able to deal with black-box units, i.e. subroutines or functions whose code is not
available.

In forward mode, Odyssée generates an augmented FORTRAN 77 code which computes
the function and one directional derivative (tangent line) of it. In reverse mode, it generates
a FORTRAN 77 code for the computation of a gradient (cotangent line).

Odyssée analyzes the FORTRAN 77 code to detect what are all the active variables, those
whose values depend on the variables with respect to which the program is differentiated.
But Odyssée may also treat calls of subroutines or functions whose code is not available,
called black-bozx units. For that purpose, it uses a data base which contains, for each unit,
the information on dependencies between the output and input variables of this unit.

IFor an introduction to the automatic differentiation and a survey of the existing tools and their func-
tionnalities, visit the web page http://www.mcs.anl.gov/Projects/autodiff/index.html of the Computational
Differentiation Project at Argonne National Laboratory

RT n° 0211
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Miscellanies

The development of Odyssée began in 1991 at the Sophia Antipolis research center of INRIA
by members of the SAFIR team. The SAFIR team is a joint team of INRIAZ, CNRS® and UNSA*%.

The current version of Odyssée is version 1.6. It includes the Odyssée engine, an inter-
preter of the command language and a MOTIF-like graphical user interface. The engine and
the interpreter of Odyssée have been written in the Objective-cAML® language, its interface
has been written in the TCL-TK language.

Only the binary versions are distributed outside INRIA and UNSA. It runs on several UNIX
platforms. It is available on request without charge for educational and non-profit research
and for internal evaluation. For this purpose, or for any other information, the development
team of Odyssée can be contacted by e-mail at odyssee@sophia.inria.fr.

This document describes completely the command language of Odyssée and the menus
of its graphical user interface. Other information can be found at the Odyssée www site at
the URL http://www.inria.fr/safir/SAM/Odyssee/odyssee.html.

Getting Started

When OQ0yssée has been successfully installed, typing odyssee or xodyssee are the two ways
to run it.

The command odyssee starts the interpreter of the O9yssée command language®. After
the banner, you will get a special prompt 0DYTOP>: Odyssée is waiting for input.

ODYSSEE
copyright INRIA - UNSA
Version 1.6 - Fri Oct 25 11:28:42 MET DST 1996

Sourcing .odysseerc...
0K
0DYTOP>

If you prefer to start the graphical user interface of Odyssée, use the command xodyssee”
and wait until the Odyssée window appears like in figure 1.1.

In both cases, once Odyssée has been started, three steps are necessary to differentiate
a FORTRAN 77 program:

2INRIA is the TFrench national institute for research in computer science and control
(http:/ /www.inria.fr/welcome-eng.html)

3cNRs is the French national center for scientific research (http://www.cnrs.fr/index.html)

4unsa is the university of Nice Sophia Antipolis (http://www.unice.fr)

Shttp://pauillac.inria.fr/ocaml/index.html

Sotherwise check if the shell variable PATH is correctly set.

7in case of problems, check that the shell variables DISPLAY and ODYSSEE are correctly set.

INRIA
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Hie Differentiation Tools Options Help
| status [ 1die

Current Unit | |

(erl4) ODYSSEE

copyright INRIA - UNSA
Version 1.6 - Fri Oct 25 11:28:42 MET DST 1996

Y

Sourcing . odysseerc. .. v

Figure 1.1: O0yssée initial window

1. to load the input FORTRAN 77 code into the internal library,

2. to select the head wunit in the internal library, the differentiation method, and the
active input variables — the variables with respect to which the input code will be

differentiated,

3. to save the code generated by Odyssée in a file and/or to visualize it on the screen.

A Sample FORTRAN 77 Code

In his document we will always consider the same example to illustrate how the commands
and the menus are working. It is described below.

Let ¢ be the numerical function of two real variables defined by:

V/exp(s?) + 22— fexp(#?) — sint

1+ 4/exp(s2?) + Sl% + 4 /exp(t2) — %

¢:(s,t) —

It may be implemented by the FORTRAN 77 code shown in figure 1.2 page 8
which is a collection of six compilation units. To compute numerical values, this
code should be linked to subroutines dedicated to the input of numerical data
and to the output of the result. These routines are not presented here, as they

are not, useful for differentiation.

RT n° 0211
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double precision function f (t)
double precision t

f = t*t

f = exp(f)
return
end

double precision function g (t)

double precision t

g=1

if (t .ne. 0.d0) then
g = sin(t)/t
endif

return

end

subroutine subl (x,y)
double precision x,y
y = £(x) + g(x)

y = sqrt(y)

return
end

subroutine sub2 (x,y)
double precision x,y
y = f(x) - g(x)

y = sart(y)

return

end

subroutine sub0 (u,v)

common zn,zd

double precision u,v,z1,z2,zn,zd

call subl (u,z1)
call sub2 (v,z2)
zn = z1 - z2

zd = 1 + z1 + 22
return

end

subroutine main (i1,i2,0)

common zn,zd

double precision i1,i2,0,zn,zd

call sub0 (i1,i2)
o = zn/zd

return

end

Figure 1.2: Example of fortran Code

INRIA
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Chapter 2

The O0yssée Concepts

2.1 OoQyssée and the Fortran 77 Code

A compilation unit is a part of a file of FORTRAN 77 code that can be compiled separately.
Therefore a compilation unit is one of the following FORTRAN 77 entities: a subroutine, a
function, a program, or a block data. Odyssée differentiate only subroutines, or functions.

The internal library is the structure where Odyssée stores compilation units:
e the units loaded by Odyssée,
e the units generated by Odyssée (results of a differentiation process).
When a new session of Odyssée starts, the internal library is empty.

The head unit is the routine chosen by the user that computes the mathematical function
to be differentiated. Usually, a mathematical function is represented as a collection of
compilation units. In order to differentiate it, the user has to give Odyssée the name of the
head unit.

2.2 0O0yssée and the Dependencies

The variables of a compilation unit is the collection of all the variables appearing in this
unit. It includes (see figure 2.1 page 11):

e formal parameters or dummy arguments : the arguments of subroutines and functions,

e global variables : parts of common blocks,

RT n° 0211
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e local variables : other variables.

One must notice that Odyssée considers the function name as a variable, as it is attached
to the output value of the corresponding function.

The input and output variables of a compilation unit are global or dummy variables.

e input variables are the non-local variables which should have a value attached to before
the unit could be run,

e output variables are the non-local variables which are modified when the unit is run.

Note that some variables may be at the same time input and output variables (see figure
2.2 page 11).

The dependencies are defined between the input and the output variables of a compilation
unit: an output variable depends on an input variable when it is necessary to know the value
of the input variable to be able to compute the output variable. For each compilation unit,
it is possible to define a function f from the set O of its output variables to the set P(Z) of
the subsets of the set 7 of its input variables:

0O — PO
o +— {i1,-..,in}

f

such as 7 € f(o) if and only if it is necessary to know the value of ¢ to compute the value of
0.

In fact, it is even possible to define two such functions, one concerning the control-
dependencies, the other concerning the value-dependencies. The following example shows
the difference between control-dependencies and values-dependencies:

In the FORTRAN 77 instruction

if (x.gt.0.) then

z =y
end if

the variable z is control-dependent on the variable x and value-dependent on the
variable y.

The only dependencies considered by Odyssée are the value-dependencies.

The information base is the structure where Odyssée stores, for each unit all the necessary
information on the non-local variables and on the dependencies between them:

e its input dummy variables,

e its input global variables,

INRIA
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subroutine sub0 (u,v)<— formal parameters

common zn,zd «—— —— global variables

double precision u,v,zl,z2,zn,zd

N

call subl (u,z1)
call sub2 (v,z2)
zn = z1 - z2

zd =1+ z1 + z2
return

end

local variables

Figure 2.1: different variables

globals

output

dummies

Figure 2.2: Input / output variables
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e its output dummy variables,
e its output global variables,
e the dependencies between its output variables and its input variables.

The entry in this base for each unit is filled with default values when the unit is loaded
and is really computed when the system performs the analyse of the code. These entries
may also be changed by the user through an information file (see section 3.2).

An active variable is a variable that depends on the variables with respect to which the
mathematical function must be differentiated (subset of input variables of the head unit).

The active information base is a restriction of the information base that concerns only
active variables. The active information base is also attached to a diff computation. It
does not exist before the first differentiation and is re-computed at any evaluation of a diff
command. Only the information contained in the current active information base may be
accessed.

2.3 OO0yssée and the File System

OO0yssée reads or writes information through several kinds of text files. Odyssée considers
five different types for files: fortran, include, batch, ibasis and odyssee and a special file:
.odysseerc.

Three global variables control each type of file T: T ext for the name extension, T _dir
for the directory where the files have to be written by Odyssée, and T path for a list of
path from where Odyssée reads the files.

e The fortran files are the files containing FORTRAN 77 code read as input of a load
command or generated by a diff computation and written by a getlibrary, a getunit, a
getprogram or a getdiffprogram.

e The include files are the files included by the FORTRAN 77 code to be loaded. Note
that they are in-lined in the code of the compilation units in the library.

e The batch files contain valid Odyssée commands and are executed through the load-
batch command.

e The ibasis files contain Odyssée commands that modify the information base (setdummys,
setglobals, setinout, setabstract). If an ibasis file of name (unit) Bl.(extension) where
(extension) is the value of the Odyssée global variable ibasis_ext exists, it is automat-
ically loaded by Odyssée during a diff command applied to (unit).

e The odyssee files are the files where O0yssée writes information about the internal
library like in the listunits, libgraph or getgraph command.

INRIA
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e The .odysserc file is a special batch-file automatically loaded at the beginning of any
session of Odyssée. It can also be reloaded by the loadodysserc command. It is generally
used to configure or customize Odyssée.

RT n° 0211
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Chapter 3

The O0yssée Command Language

The O0yssée character set consists of the 52 lower case and upper case letters, the 10 digits
and the special characters of the table 3.1.

\ | backslash

u | blanck

- | dash

. | dot

" | double quotes

# | sharp

/ | slash

_ | underscore

( | left parenthesis
) | right parenthesis

Table 3.1: special characters

Tokens of the OQyssée command language are strings, identifiers, lists and numbers:

e A string is a sequence of any printable characters enclosed in double quotes.
e An identifier is a letter, a dot or a slash followed by zero or more letters, digits,
dots, dashes, underscores or slashes. true and false are the identifiers corresponding to

the two boolean constants. These constants, the command identifiers and the option
names are reserved words of the language. They are listed in the table 3.2.

e A list is a sequence of tokens separated by white spaces, for clarity those tokens may
be enclosed between parentheses.

e A number is a signed integer. On most computer architectures, it may have any value
in the range —230 ... (230 —1).

RT n° 0211
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commands others
clear getsymbols quit -cl
clearaddedunits getunit remove -cotangent
computeibasis getvar roundoffmain | -h
copyright help roundoffunit | -head
diff libgraph save -0

exit listunits saveibasis -opt
getabstract load setabstract -optloops
getactiveinout loadbatch setdummys -output
getaddedunits loadibasis setglobals -tangent
getdependency  loadodysseerc  setinout -tl
getdiffprogram  makeblock setvar -variables
getgraph preprocess shell -vars
getinout print slice

getlibrary print2 stratlist false
getprogram printunit version true

Table 3.2: reserved words

An input of the Odyssée interpreter consists of a single statement usually referred to as a
command line. However a line, i.e. a sequence of characters followed by a newline character,
may contain an incomplete statement. And a statement may be continued from line to line
by preceding the newline character by a backslash. In this case, both the backslash and the
newline are ignored by Odyssée.

When the parser of O0yssée “sees” a sharp character anywhere on a line, any following
character until the next newline is treated as a comment.

A command line is a sequence of tokens separated by white spaces — a white space is either
a blank or a tabulation. The first token of a command line should be a valid command name.
Each command has its own syntax described in one of the following sections.

Except in a few cases — namely when reading arguments of an help command, Odyssée
does not distinguish between an identifier and a string.

INRIA
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3.1 The Internal Library Related Commands

3.1.1 Modifying the Internal Library

clear
Resets the internal library to the empty set.

load (file,) [{file;) ... (filex)]
Loads the compilation units from the specified FORTRAN 77 file(s) in the internal
library.

If the name (file;) has an extension, then Odyssée is looking for the file {file;).
Otherwise, Odyssée is looking for the file (file;) . (extension) where (extension) is
the value of the Odyssée global variable fortran _ext.

load returns an error message if no file of the given name(s) are found in one of the
directory listed in the O9dyssée global variable fortran _path. Odyssée also returns
an error message if any file found contains anything else but valid FORTRAN 77
compilation units.

Note that, if there is an include statement in the loaded code, it is necessary to
have properly set the Odyssée global variable include path.

remove {unit)
Removes the compilation unit of name (unit) from the internal library.

remove returns an error message if (unit) is not the name of a compilation unit
of the internal library.

clearaddedunits
Resets the list of the added units to the empty list.

3.1.2 Displaying FORTRAN 77 Code

getlibrary, getunit, getprogram and getdiffprogram are used to view units from the internal
library.

Those four commands may all be invoked with an optional (file) parameter. If this
parameter is present, their output is printed in a file, otherwise it is displayed on the standard
input. If the name (file) has an extension, then Odyssée is writing in the file of name (file).
In the other case, Odyssée is writing in the file of name (file) . (extension) where (extension)
is the value of the Odyssée global variable fortran ext. getlibrary, getunit, getprogram and
getdiffprogram are writing FORTRAN 77 files in the directory defined by the Odyssée global
variable fortran _dir. They do not produce any warning message if the file of name (file) or
of name (file) . (extension) already exists in this directory.

The format of the output of these four commands may be tuned by resetting Odyssée
global variables like all _uppercase, do_indentation, if _indentation, continuation _char or
blank line after_statement, see section 3.6 for further details.

RT n° 0211
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getlibrary [{file)]
Displays all the compilation units from the internal library.

ODYTOP> load exemple
ODYTOP> getlibrary
SUBROUTINE main (il, i2, o)

COMMON // zn
COMMON // zd
DOUBLE PRECISION il, i2, o, zn, zd

CALL sub0(il, 12)
o = zn/zd

getprogram (unit) [(file)]
Displays the set of the compilation units corresponding to the program whose
head unit is the compilation unit of name (unit) (see figure 3.1 page 19).

Depending on the computation performed by Odyssée during the session, getpro-
gram may add comments to the original code of the units giving the informations
stored in its active information base.

getprogram returns an error message if (unit) is not the name of a compilation
unit of the internal library.

getdiffprogram (unit) [(file}]

Displays the set of the compilation units corresponding to the program whose
head unit is the compilation unit of name (unit), provided that this unit is the
head unit of a program generated by a diff command (see figure 3.2 page 20).

Even if some initial units — not generated by a diff command — belong to the
program, getdiffprogram only displays the units generated by the diff command.
The code of these units includes some comments providing informations stored
in the active information base of Odyssée.

getdiffprogram returns an error message if the name (unit) is not the name of a
compilation unit of the internal library generated by a diff command.

INRIA
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ODYTOP> getprogram sub2
COD Odyssee 1.6 - Fri Oct 25 11:28:42 MET DST 1996

COD Program : sub2

COD Unit : sub2
SUBROUTINE sub2 (x, y)

DOUBLE PRECISION x, y

y = £(x)-gx)
y = sqrt(y)
RETURN

END

COD Unit : f
FUNCTION f (t)

DOUBLE PRECISION t
DOUBLE PRECISION f

f = t*xt
f = exp(f)
RETURN
END

COD Unit : g

FUNCTION g (t)

DOUBLE PRECISION t
DOUBLE PRECISION g

g=1

IF (t.NE.0.d0) THEN
g = sin(t)/t

END IF

RETURN

END

Figure 3.1: getprogram sub2

RT n° 0211
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0DYTOP> diff -tl1l -h g -vars t
ODYTOP> getdiffprogram gtl

Cop

CcaoD
coD
CcoD

coDp
CcoD
CcoD
CcoD
coD
CcoD

Odyssee 1.6 - Fri Oct 25 11:28:42 MET DST 1996

Program: gtl
with respect to dummys: t
strategy: Standard

Unit: gtl

Differentiated from the unit: g
Active IN  dummys: t

Active OUT dummys: g
Dependencies between OUT and IN:
g<-- t

SUBROUTINE gtl (t, g, tttl, gttl)

DOUBLE PRECISION t
DOUBLE PRECISION g
DOUBLE PRECISION sdOis
DOUBLE PRECISION gttl
DOUBLE PRECISION tttl
DOUBLE PRECISION sdOisttl

g=1
IF (t.NE.0.d0O) THEN
gttl = 040

sdO1sttl = 040
sdO1sttl = 040
sd01sttl = tttl*cos(t)
sd01s = sin(t)

gttl = 040
gttl = (sdOlsttl*t-sdOls*tttl)/t**2
g = sd01s/t
ELSE
gttl = 040
sdO1sttl = 0dO
END IF
RETURN
END

Figure 3.2: getdiffprogram gtl

INRIA
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getunit (unit) [(file)]
Displays the compilation unit of name (unit).

getunit returns an error message if (unit) is not the name of a compilation unit
in the internal library.

ODYTOP> getunit sub2
SUBROUTINE sub2 (x, y)

DOUBLE PRECISION x, y

y = £(x)-g(x)
y = sqrt(y)
RETURN

END

printunit (unit)
Displays the compilation unit on the standard output in an extended format
with statements numbers.

printunit returns an error message if (unit) is not the name of a compilation unit
in the internal library.

ODYTOP> printunit sub2

[ Top 1 SUBROUTINE sub2 (x, y)

[ Decl ] DOUBLE PRECISION x, y, f, g
[ Stat 1] y = £(x)-g(x)

[ Stat 2 ] y = sqrt(y)

[ Stat 31 RETURN

[ Bottom ] END

3.1.3 Displaying Information

listunits, getgraph, and libgraph are used to visualize informations on the contents of the
internal library, getaddedunits to visualize the list of the new added units.

The three first commands may all be invoked with an optional (file) parameter. If
this parameter is present, their output is printed in a file, otherwise it is displayed on the
standard output. If the name (file) has an extension, then Odyssée is writing in the file of
name (file). In the other case, Odyssée is writing the file of name (file) . (extension) where
(extension) is the value of the Odyssée global variable odyssee ext. listunits, getgraph, and
libgraph are writing FORTRAN 77 files in the directory defined by the Odyssée global variable
odyssee _dir. They do not produce any warning message if the file of name (file) or of name
(file) . (extension) already exists in this directory.

RT n° 0211



22

Christéle Faure , Yves Papegay

listunits [{file)]
Displays the list of the compilation units of the internal library: for each compi-
lation unit, its name and its type (Function or Subroutine) are listed.

ODYTOP> load exemple
ODYTOP> listunits
Function f

Function g
Subroutine main
Subroutine subO
Subroutine subl
Subroutine sub2

getaddedunits
Displays the list of the names of the new added units.

libgraph [(file)]
Displays a representation of the call graph of all the compilation units in the
internal library.

ODYTOP> libgraph

main +- subQ0 +- subl +- f
-8

+- sub2 +- f

-8

getgraph (unit) [(file)]
Displays the sub-graph of the call graph whose head unit is the unit of name
(unit).

getgraph returns an error message if the name (unit) is not the name of a com-
pilation unit of the internal library.

ODYTOP> getgraph subil

subl +- f
-8

3.2 The Information Base Related Commands

3.2.1 Displaying Information

getinout and getabstract are used to visualize informations stored in the information base.

Those two commands may both be invoked with an optional (file) parameter. If this

parameter is present, their output is printed in a file, otherwise it is displayed on the standard

INRIA
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input. If the name (file) has an extension, then Odyssée is writing in the file of name (file).
In the other case, O9yssée is writing the file of name (file) . (extension) where {extension) is
the value of the Odyssée global variable odyssee ext. getinout, and getabstract are writing
FORTRAN 77 files in the directory defined by the Odyssée global variable odyssee dir. They
do not produce any warning message if the file of name (file) or of name (file) . (extension)
already exists in this directory.

getinout (unit) [(file)]
Displays the input and the output variables of the compilation units belonging
to the program whose head unit is the unit {unit).

getinout returns an error message if the name (unit) is not the name of a compi-
lation unit of the internal library.

ODYTOP> getinout subO
Unit : subO

IN dummys: v u

IN globals: zd zn
0UT dummys: v u

OUT globals: zd zn

Unit : subl
IN dummys: y x
0UT dummys: y x

Unit : f
IN dummys: f t
0UT dummys: f t

Unit : g
IN dummys: g t
0UT dummys: g t

Unit : sub2
IN dummys: y x
0UT dummys: y x

getabstract (unit) [{file)]
Displays the dependencies between the input and the output variables of the
compilation units belonging to the program whose head unit is the unit (unit).

getabstract returns an error message if the name (unit) is not the name of a
compilation unit of the internal library.

ODYTOP> getabstract subQ

Unite : sub0
COD Dependencies between OUT and IN:
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u<-- zd zn vu
v <-- zd zn v u
zn <-- zd zn v u
zd <-- zd zn v u

Unite : subl

X <-- yXx
y<-—- yx
Unite : £
t <-- £t
f <-- £ 1t
Unite : g
t<- gt
g<-- gt

Unite : sub2
x <-- yXx
y<-- yx

3.2.2 Modifying the Information Base

computeibasis makes Odyssée analyze the code to find the dependencies between variables.
This computation is automatically performed before any differentiation.

setdummys, setglobals, setinout, setabstract allow the user to provide Odyssée with infor-
mation on the variables of the compilation units. They are particularly useful to provide
information on variables of black-box subroutines whose code is not available. They can
also be used to overwrite information computed by Odyssée.

These four commands are not supposed to be used at the interpreter level: they are
normally used inside information base files which are automatically loaded by the system
before any differentiation. Any invocation of one of those four commands at the interpreter
level will have no effect on further computeibasis or diff commands.

When the user wants to modify an entry of the information database attached to the
head unit {(unit), he has to define an information file: a file of name (unit) BI.{extension)
where (extension) is the value of the Odyssée global variable ibasis_ext and to store it in
one of the directory of the Odyssée global variable ibasis_path.

computeibasis (unit)
Computes the information base of the program whose head unit has the name
(unit).

setdummys (unit) (var_list)

Sets the list of the arguments of the unit of name (unit) to the list of variables
(var_list).
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setglobals (unit) (var list)
Sets the list of the global variables of the unit of name (unit) to the list of
variables (var _list).

setinout (unit) (var_list_1) (var_list_2) (var_list_3) (var_list_4)
Sets the lists of the input and output dummies and global variables of the unit
of name (unit).

The list of input dummies is set to the list of variables (var list 1), the list
of output dummies to the list (var list 2), the list of input global to the list
(var_list_3), and the list of output global to {var list 4).

As a side effect, setinout sets the dependencies between variables to their default

value: each output variable depends on all the input variables.

setabstract (unit) (var list list)
Sets the lists of the dependencies between the input and the output variables of
the compilation unit of name (unit).

3.3 The Differentiation Related Commands

3.3.1 The diff Command

The command diff is used to differentiate a program stored in the internal library. diff
produces new compilation units and stores them in the internal library. The syntax of diff
is the following:

diff (arguments expression)
(arguments _expression) is made up of several necessary and optional arguments
given as:

-(argument__name) [(argument_ value)]

To run properly, diff requires at least three arguments:

e the name of the head unit to differentiate
e the list of the active input variables

e the method of differentiation chosen by the user

The table below gives the list of the corresponding argument names, their syntax
and their actions.
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-variables | -vars | -variables (var_list) or -vars (var_list)
Introduces the list of the active variables for differenti-
ation

-head -h -head (unit) or -h (unit)

Introduces the head unit of the program to differentiate.
diff will return an error message if the name (unit) is not
the name of a compilation unit of the internal library.

-tangent -tl Sets the differentiation method to direct mode.
The generated code will compute the tangent line of the
function.

-cotangent | -cl Sets the differentiation method to reverse mode. The
generated code will compute the cotangent line of the
function.

The tables below give the list of the optional arguments of diff, their syntax and
their actions.

-output | -o -output (file) or -o (file)

Defines the output of the diff command. By default, the
FORTRAN 77 code generated by diff is stored in the internal
library but is neither displayed nor saved in a file. Giv-
ing std as file name tells Odyssée to display the code on
the standard output. Otherwise the code is printed in a
file using the same rule than other commands displaying
FORTRAN 77 code (see section 3.1.2).

-optloops | -opt | -optloops (unit) or -opt {unit)

Tells the diff command to use a special method that
produces an optimized code for subroutines with loops.
This method can be used only if the files opt rev.f and
opt_utils.f have been load in the internal library. These
two files are included in the sub-directory fortran of the
Odyssée distribution.

3.3.2 Other Commands

A side effect of the evaluation of the diff -head (unit) -vars (var_list) command line is to
compute of the active dependencies i.e. to propagate the active input variables {var_list)
through the compilation units of the program which head unit has name (unit). These
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dependencies are stored in the active information basis attached to the diff computation.
getactiveinout can be used to visualize the information of the last computed active informa-
tion basis.

getactiveinout (unit) [(file})]

Displays the dependencies between the active input variables and the active
output variables of each unit of the program which head unit has name (unit).
If the (file) parameter is given, the output of getactiveinout is redirected to a file,
it is displayed on the standard output otherwise.

If the name (file) has an extension, then Odyssée is writing in the file of name
(file). In the other case, Odyssée is writing the file of name (file).{extension)
where (extension) is the value of the Odyssée global variable odyssee ext. When
writing in a file, getactiveinout are writing in the directory defined by the Odyssée
global variable odyssee dir. It does not produce any warning message if the file
of name (file) or of name (file).(extension) already exists in this directory.

3.4 The Units Related Commands

slice (unit) (var_list)
Generates an unit equivalent to the unit of name (unit) where the code is re-
stricted to the computation of the variables of the list {var_list).

makeblock (unit) (main) (sub) (number _list)

Builds the subroutine of name (sub) with the statements of the routine of name
(unit) which number are in the list (number_list). Create the routine of name
(main) which is equivalent to the routine of name (unit) but contents a call to
the subroutine (sub).

ODYTOP> printunit subO

[ Top ] SUBROUTINE subO (u, v)

[ Decl ] COMMON // zd, zn

[ Decl ] DOUBLE PRECISION u, v, zl, z2, zn, zd
[ Stat 1 1] CALL subi(u, z1)

[ Stat 2 1] CALL sub2(v, z2)

[ Stat 3 1] zn = z1-z2

[ Stat 4 ] zd = 1+z1+22

[ Stat 5] RETURN

[ Bottom ] END

ODYTOP> makeblock sub0 subOs sub3 (3 4)

ODYTOP> getunit subOs
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SUBROUTINE subOs (u, v)

EXTERNAL sub3
COMMON // zd, zn
DOUBLE PRECISION u, v, zl, z2, zn, zd

CALL subil(u, z1)
CALL sub2(v, z2)
CALL sub3(z2, =z1)
RETURN

END

ODYTOP> getunit sub3

SUBROUTINE sub3 (z2, z1)

COMMON // zd, zn
DOUBLE PRECISION z1, z2

zn = z1-z2
zd = 1+z1+z2
RETURN

END

3.5 The System Related Commands

3.5.1

Loading Batch Files

loadbatch (batchy) [{batchs) ... {batchy)]
Attempts to execute the specified batch file(s).

If the name (batch;) has an extension, then Odyssée is looking for the file
(batch;). Otherwise, Odyssée is looking for the file (batch;) . (extension) where
(extension) is the value of the Odyssée global variable batch ext.

loadbatch returns an error message if no file of the given name(s) is found in one
of the directory listed in the Odyssée global variable batch path. Odyssée also
returns an error message if any file found contains anything else but a sequence
of valid command lines of this language.

If the execution of a batch file produces an error then the command lines of the
next files are not executed.

loadodyseerc
Attempts to execute the special init batch file HOME/.odysseerc
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3.5.2 Configuration of the System

getvar (var)
Displays the value of the Odyssée global variable (var) (see 3.6).

setvar (var) (value)
Sets the value of the variable (var) to (value).

setvar returns an error message if the type of (value) is not compatible with the
predefined type of (var) (see 3.6).

3.5.3 Miscellaneous Commands

help [(command)]
help without argument displays a list of all the commands of the Odyssée lan-
guage.

help followed by a string which is the name of a command of the O9dyssée language
displays a short description of this command including its syntax.

help followed by anything else produces an error message.

shell (string)
Sends (string) to the shell.

version
Displays the current version number of Odyssée.

copyright
Displays the copyright banner of Odyssée.

exit
Terminates Odyssée without saving anything.

quit

Terminates Odyssée without saving anything.

3.6 The O0yssée Global Variables

In this section, all the Odyssée global variables are described. Initialized to their default
values when O0yssée starts, these variables allow the user to change the configuration of the
system.
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3.6.1 Methods of Automatic Differentiation

minimal_split is the only global variable used for the configuration of the automatic differ-
entiation method. It is a boolean variable whose default value is true. When false, O9yssée
splits all the algebraic expression in the input code into elementary operations, otherwise,
the constants and the arguments of the functions are isolated in local variables.

3.6.2 Format of Generated FORTRAN 77 Code

Variable Type | Default | Comment

all _uppercase boolean true When false, only the FORTRAN 77 key-
words of the generated code are dis-
played with uppercase letters, otherwise,
the whole code is written with uppercase

letters.

do_indentation integer 3 Tunes the indentation of the body of a do
loop in the generated code. Unit is a white
space.

if _indentation integer 2 Tunes the indentation of the body of a if

statement in the generated code. Unit is a
white space.

continuation__char string : Defines the continuation char.

blank _line_after_stat | boolean | false | When true, an empty line is inserted after
any statement in the FORTRAN 77 gener-
ated code.

parenthesis_level integer 0 Tunes the level of parenthesis in the gener-
ated instructions. Default correspond to a
minimal level of parenthesis.

INRIA



O0yssée Version 1.6 The User’s Reference Manual

31

3.6.3 Input and Output through Files

Variable Type Default | Comment

fortran_ext string f Extension of the FORTRAN 77 files (read
and writen)

fortran_path | list of strings () List of the paths used to read FORTRAN 77
files.

fortran _dir string Name of the directory where Odyssée
writes the FORTRAN 77 files.

include ext string inc Extension of the include files (read and
writen)

include path | list of strings () List of the paths used to read include files
of the FORTRAN 77 code.

include dir string Name of the directory where OJyssée
writes the include files.

batch _ext string batch | Extension of the batch files (read and
writen)

batch path | list of strings () List of the paths used to read batch files.

batch _dir string i Name of the directory where Odyssée
writes the batch files.

ibasis__ext string bi Extension of the information base files
(read and writen)

ibasis__path list of strings () List of the paths used to read information
base files.

ibasis__dir string Name of the directory where OJyssée
writes the information base files.

odyssee _ext string od Extension of the file to be written which
may not be read again by Odyssée.

odyssee _dir string () Name of the directory where OO0yssée
writes the files which are not supposed to
be read again.

home _dir string HOME | Home dir of the user (Odyssée point of

view).
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Chapter 4

The O0yssée Graphical User
Interface

The graphical user interface has been designed with the help of the Tk toolkit. Therefore
it has a MOTIF look-and-feel with pop-up windows, menus and sub-menus, highlighting of
pre-selected and selected items, radio buttons, scrollable windows .. .see figure 4.1.

The main window of the O0yssée graphical user interface consists in three different parts :

Hle Differentiation Tools Options Help
Current Unit  |Subroutine sub0 | Status I Idle
SUBROUTINE main (il, i2, o) X

COMMON // =d, zn
DOUBLE PRECISION 11, 12, o, =n, =zd

CALL subD{il, 12}
o = zn/fz

RETURN

END

FUNGTION g (&)

DOUELE PRECISION &
DOUBLE PRECISION g

g = sin(t)/t
RETURN
END

SUBROUTINE sub0 {u, w)

[ | [ I —

COMMON // zd, zn
DOUELE PRECISION w, v, =1, =2, =n, =d

CALL subliu, =1}
NALT, snh i, =21 /

Figure 4.1: the O0yssée graphical user interface window
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e the menubar with four active menus used for sending commands to Odyssée, and a

Help menu,

File Differentiation Tools

Options

Help |

e the status bar with an active button to select the current unit in the internal library,
and two information windows displaying the name of the current unit and the status
of the engine of O0yssée.

Current Unit ISubroutine subDl

| Status I ldle |

e the display frame, which can be divided in several views, used for the

the FORTRAN 77 units of the internal library

SUBROUTINE main (i,

COMMON // =d,
DOUELE PEECISION 11,

12, o)

Zr

12, o, zn, =d

CALL subO{il, 12}

o =

END

zn/zd
RETURN

visualization of

|

FUNCTION o (&)

DOUELE PEECISION t
DOUBLE PREECISION g

g = sin(t) /&
RETURN

EnD

bl [

SUBROUTINE subl (u, w}

COMMON // =zd, zn

DOUELE PRECISION u, W,

CALL sublfu,
CATT. =11k

zl, zZ, zn, zd

z1})
204

|_|/‘| =l

B

In the current version of Odyssée, the Help menu is restricted to one item avout aI which
provides the informations on the version of Odyssée in a pop-up window as shown below

(Click on Ok to dismiss it).

Odyssee
Wargion : 1.6 - Fri Oct 25 11:28:42 MET DST 1396

Ok
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Load source 1
Clear library i
Save sellings t
Hddd view a
Remove current view r
Quit q

Figure 4.2: the File menu

Load source 1
Save source s
Clear library C
Save settings t
Add view a
Remove current view r
Quit ]
fofsafiripapegay/Odysseefdocfexemplesfexemple.t

Figure 4.3: the extended File menu

4.1 The File Menu

There is seven items in the File menu when beginning a new session of Odyssée (see figure
4.2).

The Save item stays grayed and the Save feature is disabled as long as the internal library
is empty. When FORTRAN 77 files are loaded in the internal library of Odyssée, the File
menu is extended by items labeled with the names of these files (see figure 4.3).

Selecting one of those items is a shortcut to reloading the corresponding file in the internal
library of Odyssée.

4.1.1 The Load source Button

The Load source I | item invokes the load command of the language of Odyssée to load in
the internal library the compilation units of selected file(s). A dialog window like in figure
4.4 appears on the screen for the selection of the file(s) to load.

In the display area of the dialog-window are listed the files of the directory whose name
appears in the Pathname field and matches the value of the Selection pattern field.

Files are selected by clicking on them, then the name(s) of selected file(s) are grayed in
the display area and appear(s) in the Filename field.
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Select file to load:

testl.f
teste.f

Azl 1
Pathiname: |fosaﬂn’papegaya’Odyssee!docfexemples l

Filename: |exemp|e.f l

Selection pattern:i".f E_l hulti select _j Show all files
(6]:3 | Rescan | Cancel I

Figure 4.4: the Load source dialog window

When the selected file is a directory, its name is appended to the pathname by double-
clicking on it and then the files corresponding to the selection pattern are listed in the display
area.

Clicking on the Selection pattern button offers a selection of possible extensions.

Pathname, Filename and Selection pattern fields can also be edited in the corresponding
frames.

Multiple selection is allowed when the Multi select check-button is activated. Double-
clicking on a name will append it to the Filename list.

Activation of the Show all files check-button causes Odyssée to list all the files of the
Pathname directory — even the files that start with a dot — in the display area.

Clicking on the Cancel button interrupts the loading process and causes O9dyssée to return
to its previous state.

The Rescan button is used for updating the list of files selectable.

Once the selection has been done, clicking on the Ok button invokes the load command
with the selected file(s) as argument(s).

An error window is popped up if no file of the selected name is found in the pathname
directory or if any found file is a syntactically incorrect FORTRAN 77 file.

4.1.2 The Save source Button

When enabled, the save source s| item invokes the getunit command of the command
language of O0yssée to save the current unit in the selected file. A dialog window like in
figure 4.5 appears on the screen for the selection of the file.

In the display area of the dialog window, the files of the directory which name has the
value of the Pathname field and matching the value of the Selection pattern field are listed.
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Select file to: save:

Al
exemplef
test.f
testl.f
teste f

=l 1
Pathiname: |fosaﬂn’papegaya’Odyssee!docfexemples [

Filenarme: | [

Selection pattern: i =3 : | Show all files

(6]:3 | Rescan | Cancel I

Figure 4.5: the Save source dialog window

A file can be selected by clicking on its name, then the name of the selected file is grayed
in the display area and appears in the Filename field.

When the selected file is a directory, its name is appended to the pathname by double-
clicking on it and then the files corresponding to the selection pattern are listed in the display
area.

Clicking on the Selection pattern button offers a selection of possible extensions.

Pathname, Filename and Selection pattern fields can also be edited in the corresponding
frames.

Activation of the Show all files check-button causes Odyssée to list all the files — even the
files that start with a dot — of the pathname directory in the display area.

Clicking on the Cancel button interrupts the saving process and causes OJdyssée to return
to its previous status.

The Rescan button is used for updating the list of selectable files.

Once the selection has been done, clicking on the Ok button invokes the save command
with the current unit and the selected file as argument.

If the file already exists, it will be overwritten without any warning.

4.1.3 Other Buttons

Selecting the gear iibrary c| resets the internal library of Odyssée to the empty set.

The save settings t| saves the current values of several O90yssée global variables (gov-
erning paths and extension names) into a batch file of name .xodysseerc.batch in the directory
where Odyssée has been started. Note that this file is different from the .odysserc file and is
not loaded automatically when starting a new session of Odyssée.
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The views management buttons will be described in the section 4.2 which presents the
display area and the features to control this area.

Clicking on Quit a| terminates Odyssée without saving anything but a pop-up
window appears for confirmation.

4.2 The Display Area

To visualize several compilation units at the same time, the display area can be divided in
several views.

The add view a| button adds a new view in the display area. As the size of the
display area is controlled by the window manager, the existing views are resized when adding
a new view: the size of each view is set to the size of the display area divided by the number
of views.

The current view can be selected by clicking on it. All the views, except the current
view, are grayed. The respective size of the views can be changed by the user by moving the
separators lines (using a small drop-and-drag button on the line) as shown below:

TOMET R BEECTETOM +
FUNCTION g (t)

DOUELE PRECISION
DOUELE PEECISION g

— | ]

g = sin{t) /t
RETURN

SUBROUTINE subl (x, %)

T

DOUBLE PRECISION =, ¥

v = £ {xheaix)

'
F
|

The information of the Current Unit of the status bar concerns the current view.

The Remove current view r | button removes the current view of the display area. Whatever
the size of the remaining views, they are resized: the size of each view is set to the size of
the display area divided by the number of views. The view on top of the display area is set
as the current view, and the attached compilation unit becomes the current unit.

The left part of the status bar consists in a button labeled Current unit and a window
where the name of the current unit is displayed:

Current Unit ISubroutine subDl |

By definition, the current unit is the compilation unit displayed in the current view.

Clicking on the Current unit button invokes the listunits command and pulls up a menu
like in figure 4.6 with as many (up to ten) items as units in the internal library of Odyssée.
Clicking on one of those items selects the corresponding compilation unit as current unit. If
the internal library contents more than ten compilation units then the only ten first units
are displayed and a More... item allows to access a new menu with other units.
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Function
Function g
Subroutine il
Subroutine gil
Subroutine main
Subroutine sub0
Subroutine sub0t!
Subroutine subl
Subroutine sub1tl
Subroutine sub2

More...

Figure 4.6: a sample of the Current unit button

4.3 The Differentiation Menu

Tangent linear {direct)

t

Cotangent linear (inverse) s

The two items of the Differentiation menu correspond to a call to the diff command on
the current unit with different options for the method of differentiation, respectively -tl for
direct (tangent line computation) and -cl for inverse (cotangent line computation).

The active input variables of the head unit are required prior to differentiating FOR-
TRAN 77 code. For this purpose, invocation of any of these two items causes Od0yssée to
open a new dialog window (see figure 4.7).

Unit’s variahles

Derivatives variables

Type : iGIo_baI
Alzd DOUBLE PRECISION |
zn DOUBLE PRECISION | Add
[ aoal
i Remove

o}
TR

|‘,J|I Show types |51

| Remove all

Derive

= Alu DOUBLE PRECISION |

Figure 4.7: the dialog window for Differentiation menu

The active input variables with respect to which Odyssée will differentiate the current

unit have to be selected by the user.
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The right part of the dialog window is the Unit’s variables frame. In this frame is displayed
the list of the variables of the current unit.

The variables are listed by type and only the variables of types Global, Local or Dummy
appearing in the frame Type are displayed — only the Global variables in figure 4.7.

To change the type of the variables to be displayed, click on the v button and select
the item of the menu corresponding to the selected type. Note that it is impossible to
differentiate with respect to a local variable.

The selected active input variables are listed on the left part of the dialog window: the
Derivatives variables frame.

To add a variable or a list of variables displayed in the Unit's variables frame to the
Derivatives variables frame, select their names by clicking on them and click on the Add
button.

Use Add all button to add all the variables displayed in the Unit's variables frame to the
Derivatives variables frame.

To remove a variable displayed in the Derivatives variables frame from the list of the
selected active input variables, select its name by clicking on it and click on the Remove
button.

Use Remove all button to remove all the variables displayed in the Derivatives variables
frame from the list of the selected active input variables.

The Show types check-button commands the display of the FORTRAN 77 type of the
variables.

Click on the Derive button to send the diff command to the O9yssée engine, on the Cancel
button to abort it.

4.4 The Tools Menu

Display library graph d
Execute bhatch file e
Edit current unit u

Send command to Odysseec

The Tools menu consists of six items but in the current version of Odyssée, only five of
them are implemented. That is why the Optimize unit stays grayed.

4.4.1 The Display library graph Button

The Dpisplay library graph d | button invokes the libgraph command and displays a representa-
tion of the call graph of all the compilation units in the internal library in a pop-up window
as shown in figure 4.8.
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..—l-{main |-»[5ub0 }-Esubl }-[jf |”

I~ I

Print I CIDse‘l

Figure 4.8: a sample of a call graph

Select batch file to execute: I

Al knewst

[ netscape’
.nohy
oS
adlabs

Citcel

Pathiname: |fosaﬂrfpapegay

Filename: | #odysseerc.hatch

Selection pattern:"‘.batch ’I Show all files

(6]:9 | Rescan | Cancel I

Figure 4.9: the Execute batch file dialog window

4.4.2 The Execute batch file Button

The Execute batch file e | button is used to execute the sequence of commands of a batch-
file into Odyssée. Selection of the batch file is made through a dialog window like in figure
4.9.

In the display area of the dialog-window are listed the files of the directory whose name
has the value of the Pathname field and matching the value of the Selection pattern field.

Files are selected by clicking on them, then the name(s) of selected file(s) are grayed in
the display area and appear(s) in the Filename field.

When the selected file is a directory, its name is appended to the pathname by double-
clicking on it and then the files corresponding to the selection pattern are listed in the display
area.

Clicking on the Selection pattern button offers a selection of possible extensions.
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Pathname, Filename and Selection pattern fields can also be edited in the corresponding
frames.

Activation of the Show all files check-button causes Odyssée to list all the files of the
pathname directory — even the files that start with a dot — in the display area.

Clicking on the Cancel button interrupts the loading process and causes OJyssée to return
to its previous status.

The Rescan button is used for updating the list of selectable files.

Once the selection has been done, clicking on the Ok button invokes the loadbatch com-
mand with the selected file as argument and the command lines of the batch-file are executed
by Odyssée.

An error window is popped up if no file with the selected name is found in the pathname
directory or if any files found contain anything else but valid O9yssée command lines.

4.4.3 The Make block Button

Clicking on the Make block m| button is only possible when statements of the current
unit have been selected, otherwise the item stays greyed. It invokes the menublock command
to build a subroutine with the selected statements of the current unit and a main routine
which is equivalent to the current unit and contents a call to the subroutine (see exemple
on figure 4.10). Names of the main routine and of the subroutine are prompted in a pop-up
window.

4.4.4 The Edit current unit Button

Clicking on the Edit current unit u | button opens a window for editing the FORTRAN 77
code of the current unit (see figure 4.11).

The editing facilities are the features of a very simplified emacs-like editor accepting the
control characters described in the table below where “~” stands for “control”.
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Fle Differentiation Tools Options

Help

Current Unit Status

SUEROUTINE sub0 (u, w)

CoMoN // zd, =zn
OOUBLE PRECISION w, w, =21, =2, =n, =d

1 CALL subliu, =1}
o CALL subZiw, =2)

SUBROUTINE sublb (22, &1)

COMMON // zd, =n
DOUBLE BPRECISION =zl, =2

b zrn = zl1-z2
2 zd = lizl+zl
3 RETURN

END

SUBROUTINE suhOn (u, v}

EXTERNAL s1hh
COMMON /) zd, =zn
DOUELE PRECISION w, w, el, =2, en, zd

GALL subliu, =1}
CALL suhZiw, =2}
CALL subDb(z2, z1)
END

e Lo

Figure 4.10: An exemple of use of Make block button
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SUBROUTINE maintl (il, 12, o, ilttl, ottl)

DOUELE PEECISION i1, 12, o
DOUELE PRECISION ilttl
DOUELE PRECISION ottl
EXTERNAL suh0tl

COMMON // zd, zn

COMMON /7 zdttl, znttl
DOUELE PRECISION zn, =d
DOUELE PRECISION znttl, zdttl

znttl = 040

zdttl = 040

le of the L
znttl = 04D

zdttl = 040

CALL sub0tli{il, 12, ilttl)
ottl = 040

ottl = {znttl*zd-zn*zdttl) fzd++2
o = zn/zd

RETURN

END

E]

Save modifications I Cancel |

Figure 4.11: the editing window for FORTRAN 77 code

characters | action
~f forward character
~b backward character
~a beginning of line
~e end of line
“p previous line
“n next line
~d delete character
“h delete backward
“t transpose characters
“k kill line
~o open line

The effect of the Save modifications button is to replace the original unit by the result

of the edition inside the internal library of Odyssée: if the name of the routine has been
modified during edition, then the result of the edition is saved under the new name as a new

unit of the internal library, otherwise, the original routine is overwritten.
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Subroutine gtl
|Subroutine main
Subroutine maintalo
Subroutine maintl
Subroutine subl
{5ubroutine subOtl
Subroutine subl
{5ubroutine subltl
Subroutine subZ

» getgraph sub0tl

sub0tl +- subl +- f
ded
+- zsubltl +- f
+- ftl
Ty
+- gkl
+- subZ +- f

|

getinout subdt| |

Load batch | Close | Clear | Clear il |

Figure 4.12: the interpreter window

If the result of the edition is not a valid FORTRAN 77 compilation unit, then Qdyssée
pops up an error window.

Clicking on the Cancel button aborts the edition process without changing anything.

4.4.5 The Send command to Odyssee Button

The Send command to Odysseec | button allows to use the command language of Odyssée without
exiting the graphical user interface. Commands are entered and results are displayed in an
O0yssée command window like shown in figure 4.12.

In the upper part of the window are displayed the result of the O9dyssée commands in the
same format than they would be on an interpreter window. The lower part of the window
is used for editing a line of commands The following control characters are recognized for
edition (~f: forward character, ~b: backward character, ~a: beginning of line, ~e: end of
line).
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4.5 The Options Menu

Code generation
Debug
Strategy e
Strategy parameters
Paths Settings

¥ Show declarations

The six buttons of the Options are used for setting global variables of Odyssée.

4.5.1 The Code generation Button

The  code generation | button is used to control the format of the FORTRAN 77 code
printed by Odyssée. It pops up the window below:

_1 &ll uppercase
_|1 Elank line after stat

Do indentation
3

I 1
If indentation
Z

| Jm

Parenthesis level
0

| T
Continuation char : I:
Ok | Cancel I

When the All uppercase check-button is not on, only the FORTRAN 77 keywords of the
printed code are written with uppercase letters, otherwise, the whole code is written with
uppercase letters included the names of the variables.

When the Blank line after stat check button is checked, an empty line is inserted after
any statement in the FORTRAN 77 printed code.

The Do indentation slide button tunes the indentation of the body of a do loop in the
printed code. The unit is a white space.

The If indentation slide button tunes the indentation of the body of a if statement in the
printed code. The unit is a white space.

The Parenthesis level slide button tunes the level of parenthesis in the printed instructions.
Zero corresponds to a minimal level of parenthesis

The Continuation char input field allows to enter the FORTRAN 77 continuation character
used when breaking lines of code.
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4.5.2 The Debug Button

The  Debug | button is for developers purpose only. It allows to suppress (or to
add) parts of the differentiation process executed by the diff command.
The Debug dialog box containing seven check-buttons is reproduced below:

Optimize direct
Optitnize inverse
Rewrite

Expand

Simplify

Split

_I Show statments indexes
Ok | Cancel

4.5.3 The Strategy parameters Button

The  strategy parameters | button is used for controlling the strategy used by the differentiation
algorithm of O0yssée. Four strategy options can be chosen by checking buttons of the dialog
window:

W Compute Trajectory
W Bemove Useless Dummys
W Optimize Storage
W Minimal Split
(814 | Cancel |

In the current version, only the strategy associated to the Minimal split button is imple-
mented.

When the button is not checked, Odyssée splits all the algebraic expression in the input
code into elementary operations, otherwise, the constants and the arguments of the functions
are isolated in local variables.

4.5.4 The Path settings Button

The  Paths settings | button is used to set the path and the extensions of the names of
files for input or output. It pops up the window below:

fortran path | fartran ext |t
include path 1. include ext 'gi'nc
batch path | batch ext |batch
ibasis path |. ibasis ext |bi
Ok | Cancel |

The several input fields allow the user to redefine the paths and the extensions of files read
or written by Odyssée (FORTRAN 77 units, include FORTRAN 77 files, batch files, information
base files).
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4.6 Other Items

The Strategy button is not yet implemented.

The M Show declarations | button is a check button which control the display of the FOR-
TRAN 77 compilation units. The declarations of variables inside the FORTRAN 77 routines
are shown only when this button is checked.
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head unit, 7, 9
help, 29

identifiers, 15

information base, 10
information file, 12

input and output variables, 10
input variables, 10

internal library, 7, 9

libgraph, 22
lists, 15
listunits, 22
load, 17
loadbatch, 28
loadodyseerc, 28
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numbers, 15
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printunit, 21

quit, 29

remove, 17

setabstract, 25
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setvar, 29
shell, 29



50 Christéle Faure , Yves Papegay

slice, 27
strings, 15

value-dependencies, 10
variables, 9
version, 29

white space, 16
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